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Правовая информация
Торговая марка Schneider Electric и любые товарные знаки Schneider Electric SE
и ее дочерних компаний, упоминаемые в данном руководстве, являются
собственностью компании Schneider Electric SE или ее дочерних компаний. Все
остальные торговые марки могут быть товарными знаками соответствующих
владельцев. Данное руководство и его содержимое защищены действующим
законодательством об авторском праве и предоставляются только для
информационных целей. Запрещается воспроизводить или передавать любую
часть данного руководства в любой форме или любыми средствами (включая
электронные, механические, фотокопирование, запись или иные) для любых
целей без предварительного письменного разрешения компании Schneider
Electric.

Компания Schneider Electric не предоставляет никаких прав или лицензий на
коммерческое использование руководства или его содержимого, за
исключением неисключительной и персональной лицензии на
консультирование по нему на условиях "как есть".

Установка, эксплуатация, сервисное и техническое обслуживание оборудования
Schneider Electric должны осуществляться только квалифицированным
персоналом.

Поскольку стандарты, спецификации и конструкции периодически изменяются,
информация в данном руководстве может быть изменена без предварительного
уведомления.

В той степени, в которой это разрешено применимым законодательством,
компания Schneider Electric и ее дочерние компании не несут ответственности
за любые ошибки или упущения в информационных материалах или
последствия, возникшие в результате использования содержащейся в
настоящем документе информации.
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Информация по технике безопасности
TeSys™ island – цифровая система управления

электродвигателем

Информация по технике безопасности

Важная информация
Внимательно прочтите эти инструкции и изучите оборудование перед его
установкой, эксплуатацией и обслуживанием. Следующие специальные
сообщения могут появляться в технической документации или на
оборудовании, чтобы предупредить о возможной опасности или привлечь
ваше внимание к информации, которая разъясняет или упрощает процедуру.

Обратите внимание

К монтажу, эксплуатации и обслуживанию электрического оборудования
должен допускаться только квалифицированный персонал. Компания
Schneider Electric не несет ответственности за любые последствия,
вытекающие из использования этого материала.

Квалифицированный специалист — это человек, обладающий навыками и
знаниями в области проектирования, эксплуатации и установки
электрооборудования и прошедший обучение технике безопасности,
позволяющей распознавать связанные с изделием опасные ситуации и
избегать их.

Добавление любого символа к предупреждающей табличке “Опасность” или 
“Предупреждение” предупреждает о риске поражения электрическим током, что 
может стать причиной несчастного случая при невыполнении данных 
инструкций.

Этот символ используется для обозначения опасности. Он используется для 
предупредения об опасности травм персонала. Чтобы избежать возможных 
травм или смертельного исхода, следуйте всем инструкциям, содержащимся в 
сообщениях о безопасности.

ОПАСНОСТЬ обозначает опасную ситуацию, которая, если ее не избежать, приведет к 
смерти или тяжелому увечью.

! ОПАСНОСТЬ

ПРЕДУПРЕЖДЕНИЕ обозначает опасную ситуацию, которая, если ее не избежать, 
может привести к смерти или тяжелому увечью.

ПРЕДУПРЕЖДЕНИЕ!

ВНИМАНИЕ обозначает опасную ситуацию, которая, если ее не избежать, может 
привести к незначительной травме или травме средней тяжести.

ВНИМАНИЕ!

УВЕДОМЛЕНИЕ указывает на ситуации, не связанные с опасностью получения травм.

УВЕДОМЛЕНИЕ
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Об издании

Область применения документа
В данном документе описываются действия в программе EcoStruxure™

Control Expert Classic, необходимые для создания проекта, включающего в
себя TeSys™ island и логический контроллер / контроллер управления
перемещениями, с помощью протокола Modbus TCP.

В документе также приводится информация о следующем:
• Интеграция TeSys island в проект EcoStruxure Control Expert Classic.
• Доступ к TeSys island DTM (Диспетчер типов устройств) с помощью

программы EcoStruxure Control Expert Classic для конфигурации модулей
и процессов TeSys island с помощью аватаров TeSys.

• Использование функциональных блоков библиотеки TeSys island в
программе EcoStruxure Control Expert Classic для разработки
приложений и управления модулями аватаров TeSys.

Перед использованием данного документа пользователю рекомендуется
иметь следующие знания:

• Информация о функциональных возможностях, структуре и
конфигурации TeSys island

• Информация о функциональных возможностях, структуре и
конфигурации контроллера

Примечание по области действия
Данное руководство применимо только для:

• Программное обеспечение EcoStruxure Control Expert Classic v15.0 SP1 –
Classic

• ПЛК Modicon M580

Информация онлайн
Информация, приведенная в данном руководстве, вероятно, будет
периодически обновляться. Schneider Electric настоятельно рекомендует
использовать наиболее актуальную версию, которую можно загрузить с
сайта www.se.com/ww/en/download/.

Технические характеристики устройств, описанных в этом документе, также
опубликованы онлайн. Для доступа к опубликованной онлайн информации
перейдите на главную страницу сайта Schneider Electric.

Связанные документы

Название документа Справочный номер

TeSys island – системное руководство 8536IB1901RU

Онлайн-справка по библиотеке TeSys island DTM Входит в состав установочного
пакета

Modicon M580 – справочное руководство по аппаратным компонентам EIO0000001578

EcoStruxure Control Expert – Руководство пользователя библиотеки
элементов управления TeSys island

EIO0000004519
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Об издании
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электродвигателем

Терминология, заимствованная из стандартов
Технические термины, терминология, символы и соответствующие описания
в данном руководстве или непосредственно на устройстве, в целом,
заимствованы из терминологии или определений, приведенных в
международных стандартах.

В области систем функциональной безопасности, приводов и общей
автоматизации к таким терминам относятся, без ограничения, термины
«безопасность», «функция безопасности», «безопасное состояние», «отказ»,
«сброс отказа», «неисправность», «поломка», «ошибка», «сообщение об
ошибке», «опасный» и т. п.

Применяемые стандарты:

Стандарт Описание

IEC 61131-2:2007 Контроллеры программируемые, часть 2: Требования к оборудованию и
испытания.

ISO 13849-1:2015 Безопасность оборудования: Элементы систем управления, связанные с
безопасностью.

Общие принципы проектирования.

EN 61496-1:2013 Безопасность оборудования: Защитная электрочувствительная аппаратура.

Часть 1: Общие требования и испытания.

ISO 12100:2010 Безопасность оборудования. Общие принципы проектирования. Оценки риска
и снижения риска

EN 60204-1:2006 Безопасность машин. Электрическое оборудование машин. Часть 1: Общие
требования

ISO 14119:2013 Безопасность машин. Блокировочные устройства для ограждений. Принципы
конструкции и выбора

ISO 13850:2015 Безопасность машин. Аварийный останов. Принципы проектирования

IEC 62061:2015 Безопасность машин. Функциональная безопасность связанных с
безопасностью электрических, электронных и программируемых электронных
систем управления и контроля

IEC 61508-1:2010 Функциональная безопасность электрических, электронных, программируемых
электронных систем, связанных с безопасностью: Общие требования.

IEC 61508-2:2010 Функциональная безопасность электрических, электронных, программируемых
электронных систем, связанных с безопасностью: Требования к
электрическим, электронным, программируемым электронным системам,
связанным с безопасностью.

IEC 61508-3:2010 Функциональная безопасность электрических, электронных, программируемых
электронных систем, связанных с безопасностью: Требования к программному
обеспечению.

IEC 61784-3:2016 Промышленные сети. Профили. Часть 3: Функциональная безопасность
полевых шин. Общие правила и определения профилей.

2006/42/EC Директива по машинам, механизмам и машинному оборудованию

2014/30/EU Директива по электромагнитной совместимости

2014/35/EU Директива по низковольтному оборудованию

Кроме того, термины в настоящем документе могут использоваться, если они
заимствованы из других стандартов, в том числе:
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Стандарт Описание

IEC 60034 Машины электрические вращающиеся

IEC 61800 Электрические приводные системы с регулируемой скоростью

IEC 61158 Передача цифровых данных для измерения и управления. Полевая шина для
систем автоматического регулирования и управления технологическими
процессами

Наконец, термин «зона производства работ» может использоваться при
описании определенных опасностей. Термин имеет значение, определенное
для термина «опасная зона» в Директиве по машинам, механизмам и
машинному оборудованию (2006/42/EC) и в стандарте ISO 12100:2010.

Примечание: Указанные выше стандарты могут быть применимы или не
применимы для определенных устройств, рассматриваемых в данной
документации. Для получения дополнительной информации об
отдельных стандартах, применимых к описанным устройствам, см.
таблицы технических характеристик соответствующего устройства.

Сопутствующая информация об устройстве

ОСТОРОЖНО
УТРАТА УПРАВЛЕНИЯ
• Конструктор любой схемы управления должен учитывать

потенциальные режимы отказа контуров управления, а также
предусмотреть для определенных критических функций управления
средства обеспечения безопасного состояния во время и после отказа
контура управления. Примерами критических функций управления
являются аварийный останов, останов при переходе за установленное
положение, отключение питания и перезапуск.

• Для критических функций управления должны быть предусмотрены
отдельные или резервные контуры управления.

• Системные контуры управления могут включать в себя каналы связи.
Необходимо учитывать последствия непредусмотренных задержек при
передаче данных или отказов канала связи.

• Соблюдайте все правила техники безопасности и местные указания по
технике безопасности.1

• Перед вводом в эксплуатацию каждого экземпляра данного
оборудования его работоспособность должна быть тщательно
индивидуально проверена.

Несоблюдение данных инструкций может привести к смерти,
серьёзной травме или повреждению оборудования.

ОСТОРОЖНО
НЕЦЕЛЕВОЕ ИСПОЛЬЗОВАНИЕ ОБОРУДОВАНИЯ
• Используйте только программное обеспечение, одобренное Schneider

Electric для применения с этим оборудованием.
• При каждом изменении конфигурации физического оборудования

необходимо обновление прикладной программы.
Несоблюдение данных инструкций может привести к смерти,
серьёзной травме или повреждению оборудования.
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1. Для получения дополнительной информации см. стандарт NEMA ICS 1.1 (в последней редакции) «Рекомендации по
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систем преобразователей с регулированием скорости» или их эквиваленты, применимые в вашей местности.
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Перед началом работы
Не используйте это устройство с оборудованием, не оснащенным
эффективным защитным ограждением рабочей области. Отсутствие
эффективного защитного ограждения рабочей области оборудования может
привести к получению серьезных травм оператором оборудования.

ОСТОРОЖНО
НЕЗАЩИЩЕННОЕ ОБОРУДОВАНИЕ
• Не используйте это программное обеспечение и сопутствующее

оборудование для автоматизации с упаковочным оборудованием, не
имеющим защиты рабочей области.

• Не вставляйте руки в оборудование во время работы.
Несоблюдение данных инструкций может привести к смерти,
серьёзной травме или повреждению оборудования.

Это оборудование для автоматизации и сопутствующее программное
обеспечение используются для управления различными промышленными
процессами. Тип или модель оборудования для автоматизации, подходящие
для конкретного применения, зависят от таких факторов, как требуемые
контрольные функции, требуемая степень защиты, способы производства,
нестандартные условия, нормативные требования и т.п. В некоторых
применениях требуется более одного процессора при необходимости
обеспечения резервирования системы.

Только пользователь может знать обо всех условиях и факторах,
присутствующих при настройке, эксплуатации и обслуживании
оборудования. Следовательно, только пользователь может определить
подходящее оборудование для автоматизации и сопутствующие устройства
безопасности и блокировочные устройства. При выборе оборудования для
автоматизации и управления, а также сопутствующего программного
обеспечения для определенного применения, пользователь должен
руководствоваться применимыми местными и государственными
стандартами и нормативными требованиями. В документе Accident
Prevention Manual (Руководство по предотвращению несчастных случаев,
признано в США на государственном уровне) также содержится много
полезной информации.

В некоторых применениях, например, для упаковочного оборудования
должна быть обеспечена дополнительная защита оператора, в том числе,
ограждение рабочей области. Это необходимо, если руки или иные части
тела оператора могут попасть в область возможного защемления, что
приведет к причинению серьезных травм. Программные продукты не могут
защитить оператора от травм. По этой причине программные продукты не
могут замещать собой защиту в рабочей области.

Перед вводом оборудования к эксплуатацию убедитесь, что
соответствующие защитные и блокирующие устройства в рамках
обеспечения защиты рабочей области установлены и исправно работают.
Все блокирующие и защитные устройства, связанные с обеспечением
защиты рабочей области, должны быть скоординированы с
соответствующим оборудованием для автоматизации и программным
обеспечением.

Примечание: Координация защитных устройства и механических/
электрических блокирующих устройств для обеспечения защиты рабочей
области не рассматривается в рамках библиотеки функциональных
блоков, руководства пользователя системы и иных реализаций,
рассматриваемых в данной документации.
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Пусконаладка и испытания
Перед использованием электрических управляющих и автоматических
устройств для нормальной эксплуатации после монтажа системы
необходимо провести пусконаладочные испытания силами
квалифицированного персонала для проверки правильности работы
оборудования. Важно правильно спланировать такие проверки и
предусмотреть достаточно времени для полного и успешного выполнения
испытаний.

ОСТОРОЖНО
ОПАСНОСТЬ ЭКСПЛУАТАЦИИ ОБОРУДОВАНИЯ
• Убедитесь, что выполнены все процедуры по монтажу и настройке

оборудования.
• Перед выполнением эксплуатационных испытаний удалите со всех

устройств все прокладки и прочие временные фиксирующие средства,
используемые при транспортировке оборудования.

• Удалите инструмент, измерительные приборы и мусор из оборудования.
Несоблюдение данных инструкций может привести к смерти,
серьёзной травме или повреждению оборудования.

Выполните все пусконаладочные испытания, рекомендованные в
документации к оборудованию. Сохраните всю документацию к
оборудованию для использования в будущем.

Испытания программного обеспечения необходимо проводить в
симулированной и реальной средах.

Убедитесь, что установленная система не имеет коротких замыканий и
замыканий на землю за исключением заземления в соответствии с местными
требованиями (например, в соответствии с требованиями National Electrical
Code в США). При необходимости высоковольтных испытаний соблюдайте
рекомендации, приведенные в документации к оборудованию, для
предотвращения случайного повреждения оборудования.

Перед подачей питания на оборудование:
• Удалите инструмент, измерительные приборы и мусор из оборудования.
• Закройте дверь шкафа с оборудованием.
• Удалите заземление с входящих линий питания.
• Выполните все пусконаладочные испытания, рекомендованные

изготовителем.

Эксплуатация и регулировка
Следующие меры предосторожности приводятся в соответствии со
стандартом NEMA Standards Publication ICS 7.1-1995 (версия на английском
языке имеет преимущественную силу):

• Независимо от мер предосторожности, принятых при разработке и
производстве оборудования, а также при подборе компонентов и их
номинальных характеристик, при неправильной эксплуатации такого
оборудования возможно возникновение опасностей.

• Иногда возможно нарушить регулировки оборудования, что может
привести к его неудовлетворительной или небезопасной работе. Всегда
используйте указания изготовителя в качестве инструкций при
регулировке функциональных возможностей. Персонал, имеющий
доступ к таким регулировкам, должен быть ознакомлен с указаниями
изготовителя оборудования, а также с техникой, используемой с
электрооборудованием.
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TeSys™ island – цифровая система управления

электродвигателем

• Оператору должны быть доступны только фактически необходимые
регулировки. Доступ к другим элементам управления должен быть
ограничен, чтобы предотвратить неавторизованные изменения
эксплуатационных параметров.
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Знакомство с TeSys island

Основная линейка TeSys
TeSys – инновационное решение по управлению электродвигателями от
лидера международного рынка. Компания TeSys предлагает подключенные
эффективные продукты и решения для переключения и защиты
электродвигателей и электрических нагрузок в соответствии со всеми
основными мировыми электротехническими стандартами.

Обзор
TeSys island представляет собой интегрированную настраиваемую систему
для прямого контроля и управления низковольтными нагрузками. TeSys
island оптимизирует доступность физических модулей за счет встроенных
функций управления предварительными сигналами.

Система TeSys island предназначена для производительного и
высокопроизводительного оборудования с архитектурой автоматизации на
базе высокоскоростных сетей, связывающих устройства с ПЛК. Необходимо
избегать незапланированных оказывающихся исключительно
дорогостоящими простоев высокопроизводительного оборудования.
Система TeSys island помогает сократить незапланированные простои за
счет прогнозного обслуживания и обеспечения выполнения ремонта в
запланированное время.

TeSys island полностью интегрируется со средами разработки для ПЛК с
помощью цифровых объектов. Система TeSys island полностью
интегрируется с пакетом EcoStruxure, объединяющим устройства и
программные средства в решения по автоматизации для OEM и предприятий
машиностроения. Система также поддерживает интеграцию со сторонними
ПЛК.
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Концепция TeSys island
TeSys island описывает открытую модульную распределенную систему
ввода-вывода, состоящую из различных модулей, установленных на
объединительной плате в DIN-рейке.

A Модуль удаленного подключения

B Модуль аналогового ввода-вывода

C Модуль цифрового ввода-вывода

D Интерфейсный модуль напряжения

E Стандартный пускатель

F Пускатель SIL (уровень полноты безопасности)

G Интерфейсный модуль SIL

H Интерфейсный модуль питания

Устройство TeSys island действует в качестве узла в сети fieldbus. Модуль
удаленного подключения является основным модулем устройства. Модуль
удаленного подключения обеспечивает внутреннюю связь с модулями TeSys
island посредством ленточных соединительных кабелей и внешнюю связь по
протоколу Modbus TCP.

Для получения дополнительной информации см. Системное руководство
TeSys island.

Системные требования
Для обмена данными по протоколу EtherNet/IP или Modbus TCP требуются
следующие компоненты.

Компонент Тип и версия

Программное обеспечение EcoStruxure Control Expert
Classic

Classic V15.0 SP1

Библиотека PSx DTM версия 3.14.54

Библиотека Schneider_Electric_TeSys_island_DTM_Library
версия

2.2.2 или выше

Контроллер Логический контроллер BMEP58••••
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Интеграция TeSys island в проект EcoStruxure
Control Expert Classic

Создание проекта
Примечание: Перед созданием проекта вам необходимо выяснить тип
ПЛК и объединительной платы. Это требуется для интеграции в проект.

Для создания проекта выполните следующие действия:

Этап Действие

1 Откройте программу EcoStruxure Contol Expert Classic.

2 Щелкните File > New (Файл > Создать).

Результат: На экране отобразится список ПЛК.

3 Выберите ПЛК Modicon M580 в соответствии с оборудованием, которое будет
использоваться в проекте.

1. В окне PLC (ПЛК) щелкните Modicon M580.
2. В окне Rack (Стойка) разверните пункт Modicon M580 local drop и выберите стойку.
3. Нажмите OK.

Результат:
a. Отобразится окно обработки команды. Дождитесь завершения обработки файлов

конфигурации.
b. После завершения обработки файлов на экране отобразится окно Security

enforcement (Обеспечение защиты).
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TeSys™ island – цифровая система управления
электродвигателем

Этап Действие

4 Для управления парольной защитой выполните одно из следующих действий:
• Создайте новый пароль для проекта и нажмите OK.
• Щелкните Cancel (Отмена), если пароль не требуется.
Результат: Будет создана структура проекта и отображена в окне Project Browser (Браузер
проектов).
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электродвигателем

Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Этап Действие

5 Дважды щелкните папку Configuration (Конфигурация) в представлении Structural
(Структура).

Результат: На экране отобразится физическое представление конфигурации устройства.
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TeSys™ island – цифровая система управления
электродвигателем

Добавление TeSys island в проект
Чтобы добавить TeSys island в проект, выполните следующие действия:

Этап Действие

1 Щелкните Tools > DTM Browser (Сервис > Браузер DTM).

2 Правой кнопкой мыши щелкните имя ЦПУ в окне DTM Browser (Браузер DTM) и выберите
ADD (Добавить).

Результат: На экране отобразится окно ADD (Добавить).

3 В выпадающем спиcке Protocol (Протокол) выберите Modbus over TCP (Modbus через TCP).
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Этап Действие

4 Выберите устройство TeSys island и щелкните Add DTM (Добавить DTM).

Результат: На экране отобразится окно свойств устройства.

5 В окне Properties of device (Свойства устройства) измените имя устройства и щелкните OK.
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TeSys™ island – цифровая система управления
электродвигателем

Конфигурация IP-адреса ЦПУ
Для конфигурации IP-адреса ЦПУ выполните следующие действия:

Этап Действие

1 Дважды щелкните папку Configuration (Конфигурация) в окне Project Browser (Браузер
проектов).

Результат: На экране отобразится физическое представление конфигурации устройства.

2 Дважды щелкните разъемы связи ПЛК в окне PLC bus (Шина ПЛК).

Результат: На экране отобразится окно параметров соединения ПЛК.

3 Щелкните меню Security (Защита) и выполните одно из следующих действий:
• Щелкните Enforce Security (Обеспечить защиту) для включения или отключения служб.
• Щелкните Unlock Security (Разблокировать защиту), чтобы включить все службы.
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Этап Действие

4 Щелкните меню IP Configuration (Конфигурация IP) и задайте IP-адрес ЦПУ в сети.

Примечание: IP address A (IP-адрес А) должен отличаться от Main IP address (Основной IP-
адрес).

5
Щелкните значок проверки ( ) на панели инструментов.
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TeSys™ island – цифровая система управления
электродвигателем

Конфигурация IP-адреса TeSys island
Для конфигурации IP-адреса TeSys island выполните следующие действия:

Этап Действие

1 Дважды щелкните ЦПУ в окне DTM Browser (Браузер DTM).

Результат: На экране отобразится окно конфигурации устройства.

2 Выберите меню TeSys island device > Address Setting (Устройство TeSys island >
Параметры адреса) и настройте IP-адрес TeSys island.

3 Щелкните Apply (Применить).

4

Щелкните значок сборки ( ) на панели инструментов.
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Выгрузка проекта TeSys island в ПЛК
Для выгрузки проекта TeSys island в ПЛК выполните следующие действия:

Этап Действие

1 Установите соединение между ПК и ПЛК, выполнив одно из следующих действий:
• Подключитесь к ПЛК по его IP-адресу.

• Подключите заземленный кабель USB (BMXXCAUSBH018) между ПК и передней панелью
ПЛК M580.

2
Щелкните значок подключения ( ) на панели инструментов.
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Этап Действие

3
Щелкните значок загрузки ( ) на панели инструментов.

Результат: На экране отобразится окно Transfer Project to PLC (Перенести проект в ПЛК).

4 Щелкните Transfer (Перенести).

Результат: Выполняется выгрузка проекта TeSys island в ПЛК.

5 Дважды щелкните ЦПУ в окне DTM Browser (Браузер DTM).

Результат: На экране отобразится окно установки соединения.

6 Выберите Channel Properties > IPAddress Source (PC) (Свойства канала > Источник IP-
адреса (ПК)), а затем щелкните OK.

7 Правой кнопкой мыши щелкните имя ЦПУ в окне DTM Browser (Браузер DTM) и выберите
Connect (Подключение).
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Этап Действие

8 Правой кнопкой мыши щелкните устройство TeSys island в окне DTM Browser (Браузер DTM) и
выберите Connect (Подключение).

9 В зависимости от требований можно выбрать один из следующих шагов для конфигурации
TeSys island:

• Если устройство TeSys island уже сконфигурировано и пользователь не хочет загружать
новую конфигурацию, щелкните правой кнопкой мыши устройство TeSys island в окне DTM
Browser (Бразуер DTM) и выберите Load data from device (Загрузить данные с
устройства).

• Если система TeSys island не сконфигурирована, а пользователь хочет загрузить новую
конфигурацию, выполните одно из следующих действий:
◦ Дважды щелкните устройство TeSys island в окне DTM Browser (Браузер DTM) и

сконфигурируйте устройство.

◦ Щелкните правой кнопкой мыши устройство TeSys island в окне DTM Browser (Браузер
DTM), а затем щекните Device menu > Additional functions > Import > Import TeSys
island Configurator Format (Меню устройства > Дополнительные функции >
Импортировать > Импортировать в формате конфигуратора TeSys island) для импорта
файлов конфигурации.
Результат: Новая конфигурация будет импортирована в программное обеспечение.
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Этап Действие

10 Дважды щелкните устройство TeSys island в окне DTM Browser (Браузер DTM) и выберите
Store data to device (Сохранить данные на устройстве).
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Интеграция TeSys island в проект EcoStruxure Control
Expert Classic

Выгрузка проекта TeSys island в ПЛК с помощью Ethernet-
кабеля

Для выгрузки проекта TeSys island в ПЛК с помощью Ethernet-кабеля
выполните следующие действия:

Этап Действие

1 Щелкните PLC > Set Address (ПЛК > Задать адрес).

Результат: На экране отобразится окно Set Address (Задать адрес).

2 Выберите IP-адрес ПЛК. Укажите для Media (среда передачи данных) TCPIP и щелкните OK.

3
Щелкните значок подключения ( ) на панели инструментов.

Результат: TeSys island интегрируется в проект и подключается к ПЛК Modicon M580 с
помощью программы EcoStruxure Control Expert Classic.
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TeSys™ island – цифровая система управления
электродвигателем

Использование библиотеки TeSys island для
разработки приложений

Обзор
Библиотека TeSys island добавлена в Types Library Manager (Диспетчер
библиотеки типов) в программе EcoStruxure Control Expert Classic. Диспетчер
библиотеки содержит функциональные блоки для поддержки разработки
приложений и управления аватарами TeSys.

Установка функциональных блоков библиотеки TeSys island
Для установки функциональных блоков библиотеки TeSys island выполните
следующие действия:

Этап Действие

1 Загрузите последнюю версию файла EcoStruxure Control Expert 2021 – TeSys island Library.zip
с сайта Schneider Electric Industry End Users and SI Campus.

2 Распакуйте содержимое zip-файла на локальный жесткий диск.

3 Щелкните Start > EcoStruxure Control Expert Classic > Types library update (Пуск >
EcoStruxure Control Expert Classic > Обновление библиотеки типов).

Результат: На экране отобразится окно Types library update (Обновление библиотеки типов).

4 Щелкните кнопку Browse (Обзор).

5 Перейдите в папку, куда вы распаковали содержимое zip-файла, выберите файл FAMILY.DSC
и щелкните Open (Открыть).
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Использование библиотеки TeSys island для разработки
приложений

Этап Действие

6 Щелкните Install family (Установить семейство).

Результат: Начнется установка файла библиотеки.

7 После успешной установки файла семейства на экране отобразится сообщение. Нажмите OK.

8 Откройте программу EcoStruxure Control Expert Classic. Щелкните Tools > Types Library
Manager (Сервис > Диспетчер библиотеки типов).

Результат: TeSys island Library 2021 отобразится в Libset V15.0 или более поздней версии.
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Конфигурация параметров проекта
Для конфигурации параметров проекта выполните следующие действия:

Этап Действие

1 Откройте сгенерированный файл .stu или .xref в программном обеспечении EcoStruxure
Control Expert Classic.

2 Щелкните Tools > Project Settings (Сервис > Параметры проекта).

Результат: На экране отобразится окно Project Settings (Параметры проекта).

3 Щелкните Variables (Переменные) и поставьте галочку Allow dynamic arrays (ANY_ARRAY_
XXX) (Разрешить динамические массивы (ANY_ARRAY_XXX)), чтобы избежать
возникновения ошибки E1208 usage of dynamic arrays is disabled (Е1208 Отключено
использование динамических массивов) при сборке проекта.

4 Снимите галочку с поля Force references initialization (Принудительная инициализация
связей).

5 Щелкните Languages > Common (Языки > Общие) и поставьте галочку Allow multi
assignment [a=b=c] {ST/LD} (Разрешить множественное назначение [a=b=c] {ST/LD}), чтобы
избежать ошибки E1203 usage of multi assignment statements is disabled (Е1203 отключено
использование выражений с множественным назначением) при сборке проекта.
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Использование функциональных блоков для разработки
приложения

Для использования функциональных блоков для разработки приложения в
программе EcoStruxure Control Expert Classic выполните следующие
действия:

Этап Действие

1 В окне Project Browser (Браузер проектов) щелкните Programs >Tasks > MAST > Logic
(Программы > Задачи > MAST > Логика).

2 Щелкните правой кнопкой мыши папку Logic (Логика) и выберите New Section (Новый
раздел).

Результат: На экране отобразится окно New Section (Новый раздел).

3 Введите имя нового функционального блока. Выберите язык FBD и нажмите OK.

Результат: На экране отобразится окно области конфигурации.
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Этап Действие

4 Щелкните правой кнопкой мышки область конфигурации и выберите FFB Input Assistant
(Ассистент ввода FFB).

Результат: На экране отобразится окно Function Input Assistant (Ассистент функциональных
входов).

5 Щелкните кнопку Browse (Обзор), расположенную рядом с экраном Function Input Assistant
(Ассистент функциональных входов).

Результат: На экране отобразится окно FFB Type Selection (Выбор типа FFB).

6 На экране FFB Type Selection (Выбор типа FFB) выберите <Libset V15.0> > TeSys island
Library 2021, а затем выберите требуемый функциональный блок и нажмите OK.
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Этап Действие

7 После выбора функционального блока щелкните OK на экране Function Input Assistant
(Ассистент функциональных входов).

Результат: Возле указателя мыши появится значок.

8 Щелкните левой кнопкой мыши область конфигурации.

Результат: На экране отобразится структурное представление функционального блока.

Для получения дополнительной информации об имеющихся
функциональных блоках и их конфигурации см. EcoStruxure Control Expert –
Руководство пользователя библиотеки элементов управления TeSys island.
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